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Welcome to AFH LD and AFH FGT 
 
The program AFH LD / AFH FGT is developed for repetitive testing, this means, e.g. 
for fatigue testing. Here it is possible to pre-set and administrate the number of repe-
titions. The relative reversal point can be simulated either based on the displace-
ment (in mm) or based on the force (in N). At cycles in force / displacement, the 
software can deactivate the testing cycle automatically by indicating a max. force 
reduction (in N). This means “non-destructive testing”). 
It serves to transfer the data from a SAUTER force measuring instrument to a PC. 
It enables you to save the measurement data as an XML file and thus to import them 
to any software compatible with XML. Additionally, it allows for a graphic presenta-
tion of the measurement data and for saving them as a graphic file. 
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1 What's new? 
This program enables you to control the test stand through AFH LD and AFH FGT 
software (only for FH and FL devices), to search for newly connected measuring in-
struments and define the emergency stop.  
Furthermore, the graphic can be flipped horizontally and you can define an activity 
when exceeding a limit value, set before. 
 

The software serves to use SAUTER length measuring devices of LD series (with 
AFH LD) and LB series (with AFH FGT). The software allows you to trigger repetitive 
functions by force or displacement. 
 
So you can do following:  
- perform activities when exceeding a limit value 
- to flip graphics horizontally 
- to look for connected devices 
- safety stop 
- to operate the test stand 
- force reduction 

2 System requirements 
 
AFH LD / AFH FGT is designed for Microsoft Windows and has got special require-
ments to the software and hardware equipment of the system. The software is dis-
tributed as a standard installation package. For more information on software instal-
lation, see chapter “Installation”. 
 
Hardware Equipment:  
– computer compatible with IBM, 
– minimum one serial port (RS-232) or USB-to-serial port converter, 
– 256 MB RAM, 
– 10 MB of available disk space, 
– SAUTER test stand, LD distance meter and dynamometer. 
 
Operating system:  
Microsoft Windows 2000/XP/Vista/7/8/10 (32 or 64 bits) 
Other requirements:  
NET Framework 2.0 
 
First steps… 
- Installation 
 
- Preparations 
 
- Main product features 
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- The context-sensitive help can be always indicated in appropriate situations by 
pressing F1- button.   

3 Installation 
 
The AFH LD, as well as AFH FGT software are distributed as a standard installation 
package. The product is designed for Microsoft Windows (Windows XP, Windows 7, 
Windows 8, Windows 10) and requires special system software and equipment (see 
“System requirements”). 
 
How is AFH LD / AFH FGT installed? 
Start the setup program (“Setup”) on the CD and proceed as per the instructions 
given by the Setup Assistant. In Windows Vista/7/8/10, the user account must have 
administrator authorisation. When the installation program is started, you will see a 
request to select the software installation language of AFH LD respectively AFH FGT.  
Options:  
- English, German 

 
 
Choose the desired language and press OK.  
Then you will see the Setup Assistant configuration window. 
In this example, installation of AFH LD will be demonstrated: 
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Press “Next” to view the dialog box with target folder selection. Here you can change 
the folder where the AFH LD (AFH FGT) software will be installed. 
 

 
In the next window, you can choose the type of installation. 
 
Options: 
Installation of the application and an appropriate list of devices. 
Device List Installation  only the device list will be installed. 
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 Press “Next” and choose if you want to create the desktop and/or task bar icon. 

 
  

In the next window, you will see the summary of installation options. Press “Install” to 
install the application. 

  
 
Once installed, you can start AFH LD (AFH FGT) to complete the setup procedure. 
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Click “Finish” to complete the installation process. 

4 Hardware installation 
 
Preparations:  
Before registering any measurement values of a SAUTER force gauge, there will be 
some steps to perform. 
 
- Install the software on the computer. 
- Connect: the force gauge (or the test stand and length meter) by a serial cable to a 
PC, (either directly to a serial interface or each with a USB serial converter for length 
meter and test stand) 
- the length meter directly to the computer by a USB cable; 
- the test stand to the computer by a serial cable. If the COM 1 port is not available, 
you can use the RS-232 / USB converter. 
 
- Switch on all devices. 
 
- Start the software. 
 
During start-up, the application will search the computer's serial ports to detect 
SAUTER force gauges and length meters. If no length meter is found, a message 
will be shown in the status bar. 
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Otherwise, if a distance meter is found, the following message will be shown: 

  
 
Annotation:  
If you don’t have a test stand with a length meter, you will not be able to perform 
force- displacement measurements. Otherwise you can only perform force- time 
measurements. If you connect  the devices after starting the software AFH LD (or 
AFH FGT), you will have to close the corresponding software and start it again, to 
enable the search for the connected devices again. 

5 Main features 
The description below is a summary of important and interesting characteristics of 
AFH LD / AFH FGT.   

5.1 Managing serial interfaces  
 
This window shows the information on the interfaces detected. It allows you to mod-
ify the parameters. However, this is not necessary, as the parameters are automati-
cally adjusted to the peripherals. Incorrect parameters may affect the software func-
tions. 

 

5.2 Measuring Instruments window 
 
View the “Measuring Instruments” window to manage the measuring instruments. It 
allows you to create or remove measuring instruments, to change their parameters, 
or to control the connection with a measuring instrument. If the measuring instru-
ment management window is not shown, you can view it by clicking 
ViewMeasuring Instruments. 
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5.3 Control of connection with measuring instrument 
 
 
 
To check the connection with a measuring instrument, 
view the “Check connection” dialog box. You can do it by 
double-clicking the equipment icon or by right-clicking the 
equipment icon and choosing “Check connection” from 
the context menu. 
 
 

5.4 Control of measuring station 

 
To enable a manual control of the test stand using 
AFH LD, view the dialog box “Control of Test 
stand”. The dialog box can also be viewed by click-
ing  view Test stand in the main menu. 
 
 
 
 
 
 

 



AFH-LD_AFH-FGT-BA-d-1811   11 

5.5 Measurement series recording 
To record a series of measurements, create a new measurement document by click-
ing FileNew.  
After the application records a measurement series containing over 500.000 measur-
ing points, no new measurement series should be opened. 

6 List of all features 
 
The following list includes all characteristic features of the AFH LD software. De-
tailed description of all individual features is provided in section “User interface”. 

6.1 Basic features 
- Recording of several series of measurements: force/time and / or force-

displacement   
- Management of serial interfaces 
- Management of measuring instruments 
- Viewing and printing of the recorded measurement data in a single chart 
- Saving the recorded measurement series as an XML 
- Multilingual user interface (see “Installation”) with contextual help 
- Modern user interface, simultaneous work with several charts using tabs — 

see “User interface” 

6.2 Measurement series recording 
- Possibility to record several series of measurements (force-time and/or force-

path) — (measurement series of up to 500,000 measured values must be re-
corded individually) 

- Printing and print preview of displayed measurement data 
- Analogue view of the current value 
- View of the chart including all measurement series with the zoom function 

6.3 Saving/export 
- XML: Click “Save” or “Save As” to save the measurement data as an XML file. 
- EMF: Click “Save Image As” to save the measurement data as an EMF file. 
- PNG: Click “Save Image As” to save the measurement data as a PNG file. 
- BMP: Click “Save Image As” to save the measurement data as a BMP file. 

 
License 
This product is distributed as a licence for one user (see “License Agreement”). 

7 User interface 
 
The objective of this section is to provide summarised information on the way of using 
and the functionality of the application depending on the menu. 
If you do not find the needed support in this section, try to find it in section “How 
to...?”.  
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Basic elements of user interface 

- Main menu 
- Tab bar 
- Status bar 

 
Other windows and dialog boxes 

- Control of Measuring Station 
- Serial Interfaces 
- Devices 
- Settings 
- Analogue Display 
- Large-Size Display 
- “About the Application...” dialog box 

 
Add-ins 
The way of interpreting different device protocols is managed in separate parts of the 
software (add-ins). An add-in is available for each special type of device. 
Use the “Settings” dialog box to download the current add-ins. 

8 Basic elements of user interface 
 
The picture below presents the basic elements of the user interface in AFH LD. 
 

 
  
Review of user interface elements  

- Main menu 
- Toolbars 
- Tab bar 
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- Graphic region 
- Properties window 
- Status bar 

8.1 Main menu 
The main menu consists of the following submenus: 

 
- File 
- Measurement Series 
- Image 
- View 
- Help 

8.1.1 File 
The “File” menu includes the following commands: 

- New — creates a new document 
- Open — opens an existing document 
- Close — closes an existing document 
- Save — saves the current document under its file name 
- Save As — saves the current document under a different name 
- Page Settings — allows you to choose a print format 
- Print — prints out the current document 
- Print Preview — allows you to preview the document to be printed 
- Exit — closes the AFH LD application 

8.1.2 New 
New command (“File” menu) 
Use this command to create a new document in AFH LD. Use the command “Open” 
to open an existing document. 
 
Shortcut 

Toolbar:   
Keyboard:  Ctrl+N 
 

8.1.3 Open 
Open command (“File” menu) 
Use this command to open an existing document in a new window. You can open 
several windows at the same time. The “Window List” menu is used to switch be-
tween documents. 

You can open new documents by clicking “New”. 
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Shortcut:  

Toolbar:   
Keyboard:   Ctrl+O 

8.1.4 Close 
Close command (“File” menu) 
Use this command to close all windows showing the current document. Before the 
document is closed, AFH LD will recommend saving all changes made in the docu-
ment. If you save the document without saving the changes, you will lose all the 
changes made after the last saving. Before closing a document without a name, AFH 
LD will show a dialog box where you can give a name to the document and then 
save it. 
You may also use the icon “Close” as shown below: 

 

8.1.5 Save 
Save command (“File” menu) 
Use this command to save the current document under its current name. If the 
document is saved for the first time, AFH LD will display the dialog box “Save As”, 
where you can name the document. To change the name or folder of an existing 
document, click “Save As”. 
 

Shortcut 

Toolbar:   
Keyboard:   Ctrl+S 

8.1.6 Save As 
Save As command (“File” menu) 
Use this command to give a name to the current document and then save it. AFH LD 
will show the dialog box “Save As”, which allows you to enter the document name. 
To save the document under its current name, click “Save”. 
“Save As” dialog box 
You can specify the location and name of a document to be saved using the following 
data entry fields: 
– File Name: Enter a new name to save the document under a different name. AFH 

LD will supplement the file name by the extension shown in “File Type”. 
– Drive:  Choose the drive where the file is to be saved. 
– Folder: Choose the folder where the file is to be saved. 
– Network: Use this option to enable connection to your own network. 
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8.1.7 Search Measuring Instruments 
Search Measuring Instruments command (“File” menu) 
Use this command to search newly connected measuring instruments and serial in-
terfaces. 
Shortcut 

Toolbar:   

8.1.8 Page Settings 
Page Settings command (“File” menu) 
This dialog box is used to change the settings of the printer and paper format. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8.1.9 Print 
Print command (“File” menu) 
Use this command to print the document. If you click this option, the application will 
show the printer dialog box, where you can select the number of pages, printer and 
its settings. 
 
Shortcut 

Toolbar:   
Keyboard:   Ctrl+P    

8.1.10  Print Preview 
Print Preview command (“File” menu)  
 
Use this dialog box to see what the printed document will look like on the page. 
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8.2 Measurement series 
The Measurement Series menu includes the following commands: 
 

- Start: starts the recording of measurement data 
- Stop: stops the recording of measurement data 
- Finish: completes the recording of measurement data 
- Manual Dispatch: sends defined device control commands to the measuring 

instrument 
- Time-Controlled Dispatch: sends defined device control commands to the 

measuring instrument at regular intervals 
 

The commands are also available on the “Measurements” toolbar: 
 

 
 

      Force / Time measurements 
 
 Force / Displacement measurements 
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8.2.1 Graphic 
The Graphic menu includes the following commands: 

- Show Tab: shows and hides the tab in the graphic window 
- Save graphic As: saves the image as a file (EMF, PNG, BMP) 
- Copy: copies the graphic region to the Windows clipboard 

8.2.2 View 
The View menu includes the following commands used to manage the serial inter-
faces and measuring instruments, and to change the program settings: 
– Serial Interfaces: shows or hides the window for serial interface management 
– Measuring Instruments: shows or hides the window for serial interface manage-

ment 
– Settings: opens the window for program settings management 
– Status Bar: shows or hides the status bar 
– Test stand: shows or hides the “Test stand” dialog box 

8.2.3 Help 
The Help menu includes the following commands: 
 
– Contents: shows the contents of the help file 
– Index: shows the index of the help file 
– Find: allows you to search specific entries in the help file 
– About the Application...: shows further information about AFH LD 

9 Toolbars 
 
The software provides two different toolbars. One includes the main menu com-
mands, and the other one – graphic commands. 

 

9.1 Main menu commands 
- New — creates a new document 

 
- Open — opens a new document 

 
- Save — saves the active document under its file name 

 
- Print — prints the active document 

 
- Search Measuring Instruments — searches the recently connected measuring 

instruments 
 

- Help — shows the help file 



18                                                                     AFH-LD_AFH-FGT-BA-d-1811 

9.2 Graphic commands 
- Copy — copies the image to the Windows clipboard  

 
- Tab — shows or hides the tab in the image window 

 
- Show All — shows the whole measurement series in the image window 

 
- Show Previous — restores the previous image size 

 

9.3 Window bar 
Use this menu to switch between different windows. 
 
 
 
 
 
 
 

9.4 Tab bar 
The tab bar is used to switch between the opened documents with measurement se-
ries. 

 
It allows you to switch between the visible tabs (screens) or to remove them from the 
window list (close). 
 
You can switch between documents with the mouse or using the keyboard, by click-
ing Ctrl+Tab or Shift+Ctrl+Tab. 
Use Ctrl+F4 to close a tab (screen). You can change the order of tabs by dragging 
them with the mouse. 
Right-clicking a tab will open the context menu, where you can display the current 
measured value in the analogue or enlarged view. 

– Measuring Instrument: shows the current measured value as an indication of the 
analogue measuring instrument 

– Large-Size Display: shows the current measured value in its own window, with 
zoom 

9.5 Graphic view 
 
 
In the graphic view, the measurement series is shown as a chart. The appearance 
can be changed using the “Settings” dialog box. It allows you to adjust the back-
ground colour, chart colour, etc. 
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9.6 Status bar 
The status bar is displayed by the bottom edge of the AFH LD / FGT  window. You 
can show or hide the status bar command by clicking “Status Bar” in the “View” 
menu. 

9.7 Other windows and dialog boxes 
The application includes other windows and dialog boxes, which are not described in 
the previous sections. Here you will find the links to appropriate sections. 

You should pay a particular attention to the dialog box “Settings”. 

9.8 List of windows and dialog boxes 
- Test stand dialog box 

- Serial Interfaces 

- Measuring instruments 

- Settings 

- “About the application” dialog box 

9.9 Dialog box for controlling the Test Stand 
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This dialog box is used to control the test stand. It is only available if a length meter 
is detected during software start-up.  
The dialog box contains three keys used to control the movement of the test stand, 
one key to reset the dynamometer, and an indicator showing the current direction of 
the test stand. Additionally, it displays the test stand's position and calculated speed. 
 
Note: 
After you have connected  the device and have  started AFH LD / AFH FGT, close 
and restart the program or select “Search Measuring Instruments” in the menu to 
detect the measuring instruments. 

9.10 Serial Interfaces 
This window shows all available serial interfaces of your computer. Select the ap-
propriate interface to view or change the settings. This will allow you to adjust the 
corresponding settings in the lower window. 
 

 
 

9.11 Measuring Instruments 
 
This window shows all the measuring instruments created. To change the proper-
ties of an individual device, select the device and adjust its properties. By right-
clicking the window you can add a new measuring instrument. 
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9.12 Settings 
 
In the “Settings” dialog box, you can change the application parameters. Some 
parameters (e.g. the ones used to change the device properties) are saved auto-
matically, and other (chart appearance) are available additionally from the AFH LD / 
FGT toolbar. However, all the most important settings can be found in this dialog 
box. 
The dialog box is divided into different categories (Graphic, View, Add-In) depend-
ing on the contents and parameter importance. This section contains the descrip-
tions of each category and parameter. 

9.13 Graphic 

 
Colour- Used to change the background of graphic image, the colour of the meas-
urement curve or of the grid. 
Graphic — switches on/off the edge smoothing function to improve the quality of the 
measurement curve 
Measurement Curve — shows / hides the grid, shows / hides the lines between 
measurement points, shows the measured values as spot symbols 
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9.13.1 Display 

 
Measuring Instrument — adjusts the colour of the limit value, scale and the hand of 
the analogue measuring instruments 
 
Large-Size Display — used to choose the background colour, type and size of font 
on the large-size display 
 

 

9.13.2 Add-In 

 
Load — downloads the current add-ins to interpret the measuring instruments’ proto-
cols (Internet connection required) 
 
Delete — deletes the unnecessary add-ins from the hard disk 
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9.13.3 Analogue Indication 
 
In this window, the current measured value is shown as an analogue measuring in-
strument. You can mark the range of limit values by choosing a different colour in the 
“Settings” dialogue box. 
 

 
Right-click the measurement series to activate the window. 

 

9.13.4 Enlarged Indication 
In this window, the current measured value is shown in the enlarged form. You can 
change the font type and colour in the “Settings” dialog box. 
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10 AFH FGT /LD Help Menu: How can I…?     
  
 In this dialog box you can find some examples, which will help you to understand the 
tasks you can realize with the AFH LG / AFH FGT product. The list down below con-
tains assignments to these examples. 
 
Exporting measuring results 
You can export test series to EXCEL 
 
Managing serial interfaces 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The program indicates all existing serial interfaces. To change the settings of an in-
terface, please select the symbol of the interface and then enter the appropriate val-
ues (baudrate, parity etc.) and adapt them in the lower part of the window.  
If the window for managing the serial interfaces cannot be seen, it can be indicated 
by using the menu function viewserial interfaces. 
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Managing measuring instruments 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The program displays all the created  devices. In this window you can create  new  
devices, delete  devices, change their properties or check the connection to a device.  
If the window for managing the devices is not visible, you can show it w ith the menu 
View->Devices. 
 
Measurement series 
To record a measurement series, you have to do the follow ing steps: 
 
- create a new measurement document by closing FileNew within the main menu 
 
- choose the device where you want to receive data from 
 
- modify the properties of the device and measurement to fit your needs  
 
- switch to measurement menu 
 
- start measurement, record measurement data either manually or timer controlled 
 
- stop measurement and save or print data 
 
- close measurement document 
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Recording a measurement series 
 
Create a new measurement document 
 

 
 
 
Choose device from the list of all previously defined devices 
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Modify the properties of the device and / or measurement to fit your needs 

 
 
The only device property to modify is Sign reversal. If this property is set to Yes, the 
sign of the measurement data w ill be inverted, e.g. if device sends 40N the meas-
urement value w ill be -40N. 
All other device properties are taken from the device defined in the device window . 
 
Following measurement properties can be modified: 
 
- Action at limit will be used to stop the test stand or to reverse the movement of the 
test stand 
- Date/Time will be entered automatically w hen starting measurement 
- Device limits enable you to receive only data within a predefined band w width 
- Displacement reversal w ill be used to reverse the displacement values (only visible 
if Measurement type is equal to Force-Displacement) 
- Lower Limit of measurement device (only active if Device limits is equally on yes)  
-Measurement type can be Force-Time, Force-Displacement series or read memory  
- Mirror horizontally is used to flip the graphic view horizontally 
- Time interval of sending device command for requesting data (This setting affects 
the number of stored values â €‹â €‹for long-term measurements and thus the m a x . 
measurement period. A maximum of 500.000 Force / Displacement or Force /Tim e 
values can be stored) 
 
- Title of measurement for saving and displaying data 
- Upper Limit of measurement device (only active if device limits is equally on yes) 
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Switch to measurement menu 

 
After switching to the measurement menu you are able to start recording a meas-
urement series 
Depending on the measurement type this menu looks a little bit different: 
Force / Time:  

 
 
Force / Displacement:  

 
 
Export measurement data to Excel 
To export a measurement series to EXCEL (or any other software capable to import 
XML-format) you just save the measurement document by Save or Save as. To im-
port the XML-file into EXCEL you use the EXCEL open command (file menu), select 
in the file type dropdown list XML Files and choose the desired measurement docu-
ment. 
 
Create a device 
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To create a new device, right click within the Devices window for displaying the con-
text menu. Then select New. The Create device dialog appears 
Choose the device type from the drop down list, enter name (or accept default name) 
of the device and click OK. The new device should appear in the device window . 

 
 
Delete a device 

 
To delete one or multiple devices, select the devices to be deleted then right click 
within the device icon for displaying the context menu. Then select Delete. 
To confirm deletion, press ok in the message box. 
 

 
 
Modify device settings 
In this property panel you can display or rather modify all device related settings. On 
the left is the name of the property and on the right the corresponding value. The 
lower panel show s a short description for the property. 
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The devices have the following properties: 

 
 
- Device type 
 
- max, min measurement rages 
 
- Device name 
- Number of data bytes the device is sending 
 
- Readability 
 
-Sign reversal (the received data value w ill be inversed)  
 
- Connection (COM port to which device is connected)  
 
- Unit 
 
- Safety stop 
 
- Device command for a stable measurement value 
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Check device connection 
 

 
 
With this dialog you can check if a device is connected to the PC and is able to 
communicate with AFH-FGT / AFH LD. 
To establish a connection, press the Connect button. If COM port is opened without 
error, the red LED is highlighted and the communication parameters will be displayed 
besides on the right. 
If the device is sending data, it is displayed in the Received data window in both 
ASCII and HEX. 
Use the Clear data button to remove all received data from the window.  
Use the Send command button to send the previously defined device command to 
the device. 
Before closing this dialog, you have to disconnect from the device by pressing the 
Disconnect button. 

Modify serial settings 

 
In this property panel you can modify all interface related settings. On the left is the 
name of the property and on the right the corresponding value. The lower panel 
shows a short description for the property. 
 
The serial interface has the following properties: 

- COM port number 
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- Baud rate (the transmission speed in bits/sec)  

- Number of data bits (number of data bits per byte) 

- Handshake protocol 

- Parity 

- Number of stop bits 
Control test stand 

 
The Control test stand dialog enables you to control the test stand and to reset the 
force measurement gauge. It can be displayed only if a displacement measurement 
device has been found at program start. Otherwise the menu item to show this dialog 
will be disabled.  
 
Control the movement of the test stand 

 
With these three buttons you can let the test stand to move upward, downward or 
you can stop the movement. The movement display in this dialog will reflect the ac-
tual movement. 
 
Reset force gauge 

 
Use this button to reset the force gauge to “zero”. 
 
Display the current movement of the test stand 

 
This movement indication shows if the test stand is moving upward, downward or if it 
rests. 

11 AFH LD: Calibration of the linear potentiometer 
 
Before measuring, you must calibrate the distance meter, if using AFH LD software. 
To this end, the delivered package includes a 100 mm reference bar, which has to be 
used for calibration.  
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To perform the calibration, proceed as follows. 
In View --> Settings, go to the following table. 
 

 
 
In “Measuring Instruments” select the appropriate length meter. The number indi-
cates the length in [mm] for which the distance meter can be used.  
To start the calibration, move the test stand to its lowest position. 

 
Then press “Apply Value”. 
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Then move the test stand up for 100 mm. While the test stand is slowly lowered 
down, position the calibration bar in such a way at the lower adjusting ring, that, after 
being moved for 100 mm, it causes the lower limit switch to power off the motor. 
(Caution! Risk of crushing) 
Press “Apply Value”.  
 

 
 
Press “Finish Calibration”. Remove the calibration bar.  
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Press OK. The calibration is completed. 
 

 
 
You will see the status on the lower left side. 
The values will be saved and will remain available after the next start-up of the appli-
cation, until the next calibration will be performed. We recommend a new calibration 
after a long period of work break or if any deviations are detected. Now everything is 
ready for initial measurement. 

12 Initial measurement (Cycle measurement) 
 
Create a new measurement series document. 
 

 
 
Choose the measuring instrument to be used (if the device is not displayed, you can 
add it in the “Measuring Instruments” window; see section 9.11). 
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In “Settings” you can set the following parameters. 
 

Measuring Instrument: here you can select the 
measuring instrument from the drop-down menu. 

- Emergency Stop: here you can set the value where 
the test stand will stop in case of emergency (do 
not set a value that exceeds the maximum load of 
the dynamometer). 

- Sign reversal: changes the direction, in which the 
curve is displayed. 

- Switch at Limit: here you can force a reversal of the 
movement direction after passing a certain dis-
tance or after reaching a pre-set force. 

- Cycles: here you can set the number of cycles. In 
case of high values (> 10,000), the software can 
run more slowly. 

- Device Limits: here you can generally specify 
whether the limit values should be applied. 

- Horizontal Reflection: activates the reflection of the 
measurement curve. 

- Measurement Type: here you can select the Force 
/ Displacement or Force / Time measurements, or 
memory readout. Force compression measure-
ments will be shown with minus- values, e.g. -50N. 

-  
- Upper Limit: here you can enter the force or 

displacement value. 
- Title: here you can name the measurement.  
- Lower Limit: here you can enter the force or displacement value. 
- Displacement Reversal: Yes or No. 
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- Time Interval: here you can set the value of the recording of measuring data within 
the scope of the software. (time interval, in which measurement values are requested 
from the force gauge). 
The setting of the time interval as well as the number of cycles has got an influence 
on the number of the memorised measured valued at long term measurements and 
with this, also on the max. testing time. You can memorise max. 500.000 measured 
values at force / displacement or force / time measurements. 

Then continue the measurement by pressing the right arrow key .  

 
 
 

 
 
Start the measurement by pressing the up or down arrow key. The test stand will 
start moving and transmitting the data to the software.  
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Measurement is completed, if the number of cycles has been achieved.  
 

 
 
After finishing the measurement, it can be saved at any desired place. 
Subsequently close the program and switch off all devices.  
 
 
 

Measurements 1 

If number of cycles is reached, 
measurement is finished 

Displacement / mm 

Force / K
N

 

Measurements 1 

Displacement / mm 

Force / K
N
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13 Further Information  

Additional resources  
Here you can find links to additional help resources (instruction manuals, technical 
data sheets etc.).  

• AFH LD / AFH-FGT documentation 
 
Links: 

• Sauter GmbH, http://www.sauter.eu/ 
Copyright © 2009-2012 SAUTER GmbH. All rights reserved.  

13.1 AFH-LD / FGT – License agreement 

 
Except if not otherwise noted, all of the documentation and software included in the 
AFH-FGT package is copyrighted by SAUTER GmbH.  
Copyright (c) 2009-2012 SAUTER GmbH. All rights reserved.  
 
Exclusion of liability:  
This software is provided "as-is," without any explicit or implied consent and without 
any warranty with regard to its suitability for a special purpose. In no event the editor 
shall be liable for any damages occurring from the use of this software.  
 
Licenses:  

1. You may install and use this software product or a previous version for the same 
operating system and use one single copy of it on a single computer. You may also 
store or install a copy of the software product on a storage device, such as a network 
server, used only to install or run the software product on your other computers over 
an internal network; however, you must acquire and dedicate a license for each sep-
arate computer on which the software product is installed or run from the storage de-
vice. A license for the software product may not be shared or used concurrently on 
different computers 
Restrictions:  

1. You may not modify this software in ANY WAY, to undergo a Reverse Engineering 
Process, decompile or disassemble 

2. You may not emulate, clone, lend, lease, sell, modify, or transfer any version of the 
software, or any subset of it. Any such unauthorized use shall result in immediate 
and automatic termination of this license and may result in criminal and/or civil prose-
cution.  

http://www.sauter.eu/
mailto:info@sauter.eu
http://www.sauter.eu/
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